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Using This Guide
This guide is designed to help you train teachers to use Kid Pix Deluxe 4 as
a learning tool in the classroom. Using a project-based learning approach,
each workshop is designed to facilitate the learning of the features and skills
by modeling a classroom activity. Once the learning model is completed,
participants apply their learning by creating their own unique classroom
activity to integrate the technology.

Workshop Delivery
Each workshop is designed to last from one to one-and-a-half hours. The
workshops can be combined and used in half-day and full-day sessions.
Each workshop includes the following components:

Learning Outcomes 
The Kid Pix Deluxe 4 features taught in the workshop

Preview 
An overview of what the participants will do during the workshop

Before the Workshop
Information to help you prepare for the workshop

Opening Activity
Each opening activity poses a question to engage the participants in a brief
discussion of how the skills presented in the workshop can be integrated in
the classroom with a focus on student learning.

Modeling Activity
The learning outcomes of the workshop are introduced to the participants
during this activity. As the instructor, you briefly model the workshop
activity as you present the new skills. The participants work at their
computers to practice the skills as you demonstrate.



Contents vii

Applying the Learning
After watching you model the skills, the participants practice what they
have learned by constructing their own document, presentation, or project.
This process allows you to walk around and coach participants as needed.
The handouts are available for additional assistance at
www.teacher2teacher.com.

Assessing
At the end of the workshop, you distribute a Workshop Assessment form to
assess what participants have learned. The participants identify their needs
for future workshops and learning opportunities.

Reflecting
As a final step, guidelines are provided to assist you in leading a participant
sharing time. 

Workshop Agenda
The value of these learning experiences is directly connected to the amount
of time participants have for hands-on learning. The following time
segments are suggested as guidelines for organizing your workshops: 

Opening Activity 5 – 8 minutes

Modeling Activity 15 – 20  minutes

Applying the Learning 30 – 45  minutes

Assessing 5 – 8 minutes

Reflecting 5 – 8 minutes

Workshop Materials
Each workshop is supported by a series of handouts that can be 
copied and distributed during the training. Electronic copies of the
handouts can be downloaded at www.teacher2teacher.com.

Modeling Activity handout(s)
Designed to support the modeling activity
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Skill Step handout(s)
Designed for use during the Applying the Learning session

Workshop Assessment form
Designed as a workshop evaluation tool

Ongoing Support
The following resources can help you prepare for the delivery of the
workshops described in this guide. They can also serve as valuable
resources for your workshop participants.

Teacher2Teacher Flip Charts
Flip Charts are designed to sit beside the computer for easy access to
common Kid Pix Deluxe 4 instructions. Tabs separate the chart topics,
making it easy to find the necessary information and allowing participants
to work at their own pace. These Flip Charts are a great complement to the
handouts found in this guide. For more information, visit
www.teacher2teacher.com or call 1-800-765-0333.

Kid Pix Deluxe 4 Help
This resource is part of the Kid Pix Deluxe 4 application. You can access Kid
Pix Deluxe 4 Help from the Help menu when Kid Pix Deluxe 4 is the active
application.



ConTemplate the
Possibilities 

LEARNING OUTCOMES

In this workshop, participants will learn how to perform the following tasks
in Kid Pix Deluxe 4:

o Create, use, and save a template

o Using Idea Machine and adding a Kid Note 

o Use the the Paint Tool

o Use the Mixer Tool

o Create a secret code

o Editing Rubber Stamp

o Print a picture

BEFORE THE WORKSHOP
o Review Using This Guide on page viii to become familiar with the

training process used in this workshop.

o Set up a large-screen projection device that is connected to your
computer.

PREVIEW
Creating a template for  a worksheet or project is an effective way
for teachers to combine teaching computer skills with academic
content. This workshop teaches participants to develop and save as
templates a variety of engaging and interactive learning materials
that can be customized to meet the needs of students.
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o Have chart paper or a white board available.

o Show teachers a pre-made template found in Kid Pix Deluxe 4’s Idea
Machine.

o Make copies of the following handouts for each participant:

o Sample Picture

o Using Idea Machine

o Adding a Kid Note

o The Paint Tool

o The Mixer Tool

o Editing Rubber Stamps

o Printing

o Workshop Assessment

o Become Familiar with the skills presented in this workshop by practicing
the modeling activities.

o Create examples of templates. Save one and use it to demonstrate how
to open and rename a template.

OPENING ACTIVITY

In the opening activity, you want to engage participants and get them
excited about the possibilities for developing templates to be used by
students to learn and reinforce skills. Point out that some of the new tools
they will be learning about in this workshop will allow them to create
interactive materials.

o To help participants understand the concept of a template, display
several letters, each written on the same stationery. The stationery is the
same; the content changes. The stationery is an example of a template.

o Then, display a pad of paper with a logo printed on it. Tear a sheet of
paper from the pad and hand one to each participant. Explain that when
a template is created it is like a pad of paper on the computer that
allows each student to take a sheet and work on it. Just as students write
their name on a sheet of paper, students personalize a file by saving it
with their own name.  

o Point out that templates are teacher-created files that can be accessed,
opened, and worked on in the classroom or computer lab by students.
Show an example of a template intended to be used by the whole
group.  
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o Ask participants to brainstorm types of materials that can be created
with Kid Pix Deluxe 4 tools and saved as a template. Write these ideas on
the white board or chart paper.

o Ask participants to brainstorm ways in which they can create useful
materials using the ability to personalize instructions. Write these ideas
on the white board or chart paper.

o Distribute the workshop handouts.

MODELING ACTIVITY

In the modeling activity, the participants will work at the computer as you
demonstrate the learning outcomes. Create a sample classroom learning
activity; then, save it to be used as a template. Reopen it, rename it, and
add to it. Participants will explore new tools, review ones they have already
worked with, and use all of them to develop template ideas. 

Creating an activity template

In this activity you will introduce some new tools and skills to participants.

1. Select Turn Small Kids Mode On from the Controls menu and click the
Text Tool.

2. To create a simple arithmetic template, use the numbers found in the
Text tray to enter the characters of a simple example, such as 3 + 4  = 7.
Click the number from the tray and then click where you would like it on
the page. Leave space between each character. Select Turn Small Kids
Mode Off from the Controls menu when you are finished.

3. Tell participants that students will select and add groups of Rubber
Stamps under the numbers to demonstrate number understanding. To
use Rubber Stamps, select the Rubber Stamps Tool from the Toolbar,
click your stamp selections from the Rubber Stamp tray, and then click
again under the appropriate number.

4. Verbal and written instructions or messages can be added to the page,
such as, “Use the Rubber Stamps on this screen to find pictures of birds
(or hats or ways of getting from place to place). Then, place the correct
number of Ruber Stamps under each number to complete the problem.”
To do this, open the file to which you would like a note added (this file
can be an Idea Machine template or one that you have created).

5. From the Teacher menu (accessed by simultaneously clicking Ctrl+T),
choose Add Kid Note. Type your message in the window provided and
click OK when you are finished.



3-4 Kid Pix Deluxe 4 Training Guide © 2006 Teacher2Teacher All rights reserved

6. To save this document to be used as a template, you can publish it to the
Idea Machine. From the File menu, select Save As, name it, and then save
it to the desired location. Then from the File menu, select Publish to the
Idea Machine. Select the appropriate Idea Machine folder to which to
save or make your own folder. Then click Save.

7. To open a template from the Idea Machine, choose Idea Machine from
the Toolbox menu and navigate to the appropriate folder. Select the file
and click OK.

Tip:  Encourage participants to create an icon to prompt students to choose
Read Text Aloud from the Speech menu to hear a message. This can be
added to any relevant pages.

Exploring the Paint Tool

In this activity, you will demonstrate some of the Paint Tool options. As you
show different features, ask participants to note ways that these fun and
interesting options can be used in lessons and activities.

1. To add a wide variety of painting techniques and interesting objects to a
picture, select the Paint Tool on the Toolbar. Click to select an option
from the Tool Options Tray. Choices include the Paintbrush, Sound Art
(uses your voice or music to direct the painting), or Spray Can.

2. Choose a color from the Color Splotch.

3. Choose the size, paint mode (Realistic or Wacky Paint Mode), and other
paint options from the Paint tray.

4. Click the page and simultaneously drag to create the paint effects. 

5. When using Mouse Mode in Sound Art, be sure to simultaneously speak
into your computer’s microphone, click the mouse, and drag the mouse
across the page to create different effects. In Microphone Mode, there is
no need to use the mouse since your voice activates the painting.

6. Experiment with the various tools in Wacky Paint Mode and challenge
participants to discover how to create some of the following effects:
spray paint, zig-zag lines, drippy paint, and spirals. Next have them try to
draw: a forest of fractal trees, a rainbow, and a brick wall.

7. To create a surprise message, in Wacky Paint Mode, use the arrows to
choose the Alphabet Text option. Then select Edit ABC Text from the
Toolbox menu. Type a message into the dialog box that appears (this
will replace existing message). Click OK. Click the mouse one time to see
a single letter; drag the cursor to see a message appear.
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Exploring the Mixer Tool

In this activity, you will demonstrate ways to create interesting changes to a
picture. Be sure that participants understand that the Mixer Tool works on
images already on the screen.

1. To experiment with the Mixer Tool effects, create a picture on the screen
with any of the tools. Select the Mixer Tool on the Toolbar, and then
choose an effect from the Tool Options Tray. Click on the screen to see
the effect. 

2. To combine effects, select another effect and then click the picture on
the screen. 

3. You can use the Mini-Mixer tool to add an effect only to where you drag
the mouse on the page. You can change the size of your mixing with the
sizing buttons.

4. To remove an effect, click the Undo Guy immediately. The Undo Guy
removes only the last effect. 

Tip:  Encourage participants to look at the icons for the Mixer Tool options
and have them predict the effects that will appear when the option is
applied.

Tip:  To encourage participants to explore all the Mixer Tool options, create
a scavenger hunt or ask a series of questions that will help them to find
answers and discover possibilities.

Secret code 

In this activity, you will demonstrate how to create, save, and print a key for
a secret code that students can use to send and receive messages.

1. To create a code key template, select Turn Small Kids Mode On from the
Controls menu and place all the letters of the alphabet in two or three
vertical columns on one half of the screen. Be sure to leave space
between the columns. Save this picture as Code Key.

2. To create a secret code, open the Code Key file, select the Rubber Stamp
Tool, and then select one stamp to stand for each letter of the alphabet.

3. To edit a Rubber Stamp, click the Rubber Stamp you wish to edit and
then click the Stamp Editor (pencil) in the Rubber Stamp tray. The Stamp
Editor window appears. Make changes to your Rubber Stamp using the
editing tools.

4. When the code is complete, save the file as Secret Code.

5. To use the secret code, choose Print from the File menu and print two
copies. Have the participants keep one copy and give the other to a
partner so that each person can write and decode a coded message.
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KID PIX DELUXE 4

APPLYING THE LEARNING

In this activity, participants will create a template of their own design.

o As they begin their projects, encourage participants to practice the skills
presented in the modeling activities. Remind them that they can
duplicate the samples provided, and/or create their own designs.

o After the participants begin their project, circulate to provide individual
and small group assistance as needed.

o Remind participants to save as they work and to refer to the handouts
for additional help.

ASSESSING

Distribute the Workshop Assessment form and ask participants to check the
skills they have learned and complete the comments section.

REFLECTING

Ask several participants to share the work they have completed and
comment on how they can have students use this idea in the classroom. 

Using Templates from the Idea Machine
Idea Machine: Use this tool to find templates to use, which are all
categorized by topic. Idea Machine can also be accessed from the Toolbox
menu.

Publishing to the Idea Machine - You can create your own
template specific to your curiculum and then publish it to the Idea Machine.

o Create a file in the Paint Zone

o From the File menu, select Save As , name it, and then save it to the
desired location.

o From the File menu, select Publish to the idea Machine.

o Select the appropriate Idea Machine folder to which to save or make
your own folder.

o Click Save.
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If you wish to add a Kid Note
to a file so that when a student
opens a particular Kid Pix
Deluxe 4 file, a note that
includes specific instructions for
the student can appear and be
read aloud, then open the file
that you would like a note
added (this file can be an Idea
Machine template or one that
you have created) and from
the Teacher menu, choose Add
Kid Note.

o Type your message in the 
window provided.

o Click OK when you are finished.

Paint Tool and Mixer Tool
Paint: Click this tool to paint.

o Choose the Paintbrush Sound Art (uses your voice or music to direct the
painting), or Spray Can tool from the Paint tray on the bottom of the
screen.

o Choose a color from the color splotch, and then size, paint mode
(Realistic or Wacky Paint Mode), and other paint options from the Paint
tray.

o Click on the page and simultaneously drag to
create the paint effects.

Tips and Timesavers
o When using Mouse Mode in Sound Art, be sure to simultaneously speak

into your computer’s microphone, click the mouse, and drag the mouse
across the page to create different effects.

o On Microphone Mode, there is no need to use the mouse since your
voice activates the painting.
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Mixer: Use this tool to create interesting changes on your picture.

o When you click on the Mixer button, the mixer tray appears at the
bottom of the screen. Choose an effect from these options and then click
your picture to watch the effect take place.

o You can use the Mini-Mixer tool to add an effect only to where you drag
the mouse on the page. You can change the size of your mixing with the
sizing buttons.

o If you don’t like the effect, click the Undo Guy
immediately. Otherwise, your picture will be changed
permanently.

Editing Rubber Stamps
o To edit a Rubber Stamp, click the Rubber Stamp you wish to edit and

then click the Stamp Editor (pencil) in the Rubber Stamp tray. The
Stamp Editor window appears.

o Make changes to your Rubber Stamp using the editing tools.

o - Pencil - allows you to draw on your stamp

o - Undo - allows you to undo your last change

o - Flip - allows yo to turn your stamp left to right

o - Color Picker - allows you to 
choose a color

o - Fill Bucket - allows you to fill
the stamp with the color
chosen in the Color Picker

o - Firecracker - allows you to
start over by erasing the
whole picture

o - Rotate - allows you to turn your stamp 90 degrees

o - Restore Original - allows you to go bck to the look of the original
stamp

Printing
In order to print your picture, from the File menu, click Print (printing
can only occur in Big Kids Mode).

Objects on the page such as, stickers, animations, and text will not show
up when the picture is printed, unless they are first flattend. To do so, go
to the Toolbox menu.



3-10 Kid Pix Deluxe 4 Training Guide © 2006 Teacher2Teacher All rights reserved
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Workshop 3: ConTemplate the Possibilities

Name:___________________________________

Now that you have completed this workshop, how confident do you feel
about performing the following tasks?

I know I need I still don’t 
Skill how to do this. more practice. get it.

Create, use, and save a template

Use the Idea Manchine for Templetes

Add a Kid Note

Use the Paint Tool

Use the Mixer Tool

Edit Rubber Stamps

Print a picture

Comments:
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Bulk pricing is based on
# of copies ordered of that
specific Style. Example: 10
MS Word 2003, 5 MS Excel
2003 and 10 Kid Pix Flip
Charts would would qualify as
25+ for a price of $22.95 ea.

* Print edition available in quantities of 25 or more, allow 3 to 4 weeks to ship.  Shaded are means Style is not Available

Total of All Styles and eBooks Ordered

Bundle Pricing Available (see reverse side for details)

Flip Charts
are award winning, 
step-by-step guides 
that provide 
instruction on 
commonly used 
software applications. 
The perfect easy 
reference guide to 
place at each 
workstation, providing 
you with your own 
personal tutor 
whenever you 
need it.

Training Guides
are structured as a 
series of professional 
development work-
shops that can be 
delivered in one-hour 
modules or used 
individually by 
teachers at their own 
pace. Each workshop 
includes clear 
instructions, sample 
projects, skill steps, 
and assessment 
opportunities.

Classroom
Activities
are loaded with ideas 
and all the materials 
you need to put the 
software to work in 
your classroom. 
Designed to meet 
standards & integrate 
language arts, 
science & math skills, 
these activities 
provide rich learning 
opportunities.

Student 
User Guides
apply to activities that 
students can relate to 
as they approach the 
workplace. Each 
book is independent 
of the other and the 
chapters contain 
skills starting at the 
beginning levels of 
use up to more 
advanced skills.

Teacher 
User Guides
are a companion to 
the Student User 
Guides, containing all 
of the skill building 
tools for each 
software title, plus 
great classroom 
activities to integrate 
technology in your 
classroom 
effortlessly.

eBooks
are an electronic 
version of the book 
delivered as a pdf 
file. Print an 
individual chapter 
as needed or view 
file on the computer 
instead of printing.
All titles and all 
types are available in 
eBook format and are 
the same price. Pay 
no shipping & 
handling.

www.teacher2teacher.com

Teacher2Teacher Styles Available For Each Title eBooks
All titles are Mac/Win unless otherwised marked Classroom Student User Teacher User All Titles 

Flip Chart Training Guide Activities Guide Guide Available
Title/Subject/Version (Quantity Desired) (Quantity Desired) (Quantity Desired) (Quantity Desired) (Quantity Desired) (Total eBooks)

Microsoft Excel 2003

Microsoft PowerPoint 2003

Microsoft Word 2003

Microsoft Access

Inspiration 7.6

Kidspiration 2.1

Kid Pix Deluxe 4.0

Microsoft Excel XP (Win) use 2003

Microsoft PowerPoint XP (Win) use 2003

Microsoft Word XP (Win) use 2003

Microsoft Frontpage XP * (Win)

Microsoft Excel 2000 *

Microsoft PowerPoint 2000 *

Microsoft Word 2000 *

Adobe Photoshop Elements 2 * (Win)

Inspiration 7.0 *

Kidspiration 2.0 *

Kid Pix Studio *

Hyper Studio 4.2 *

Apple Works 6.0 * (Mac)

StarOffice Writer 8.0 * (Sun)

StarOffice Impress 8.0 * (Sun)

Total Quantity of  Each Style

1 to 9 24.95 21.95 19.95 17.95 29.95 19.95

10+ 23.95 20.95 18.95 16.95 27.95 15.95

25+ 22.95 19.95 17.95 15.95 25.95 13.95

50+ 19.95 17.95 15.95 13.95 23.95 11.95

100+ 17.95 16.95 13.95 11.95 21.95 09.95

Cost Per Style
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Our Guarantee: If you are not happy with our product, we will
refund or replace it. Call us to receive a Return Authorization #.

Back Orders: Any item may be temporarily out of stock. You may
choose to have your order held until all items are in, or shipped as
they become available for additional per shipment charges.

Shipping: Add 10% shipping charge to your order. There is a
$8.00 minimum, with a $60 maximum shipping charge.  Additional
5% of order for 2nd day air. In-stock items are shipped within 48
hours of order receipt, please allow 10 days for your order to
arrive.  Standard shipping is by U.S.P.S.  

Please place your order by one of the following methods:

Visit www.teacher2teacher.com or   Order Toll-Free: 800-765-0333 (8:30 a.m. - 4:30 p.m. PST)

E-mail: orders@teacher2teacher.com Mail: 1321 Pine View Road, Golden, CO 80403            Fax: 866-444-7881

BILL TO:

Name______________________________________________

Title _______________________________________________

School _____________________________________________

District _____________________________________________

Address ____________________________________________

City _________________________State ______ Zip ________

Phone ____________________ Fax_____________________

E-Mail _____________________________________________

SHIP TO: (complete if different from “Bill to” information)

Name______________________________________________

Title _______________________________________________

School _____________________________________________

District _____________________________________________

Address ____________________________________________

City _________________________State ______ Zip ________

Phone ____________________ Fax_____________________

Special Discount Code ___________________________________

o Purchase Order enclosed          o Check Enclosed 
(U.S. dollars drawn on a U.S. bank only, please)

Charge my:    o American Express    o Master Card    o Visa

Account #___________________________________ Exp._________ Signature ________________________________________

MS Office Bundles (choose from 2 bundles)

Software Title Bundle
Print Cost $62.00 x ______ = ________

eBook Cost $45.00 x ______ = ________
(Save $22) Quantity _Total Cost

Lab Pack Bundle
Print Cost $554.00 x ______ = ________

eBook Cost $385.00 x ______ = ________
(Save $281) Quantity _Total Cost

Please Specify Titles and Version:

Please Specify Titles and Version:

Print Cost $180.00 x ______ = ________

eBook Cost $130.00 x ______ = ________
(Save $70) Quantity _Total Cost

1) MS Office 2003 Bundle Includes Word, Excel & PowerPoint
2003 with one Flip Chart, Training Guide & Classroom Activities of 
each title. Regular Price $200.55

Any One Title with one Training Guide, one Classroom Activities and 
25 Flip Charts. Regular Price $665.65

All Styles of Any One Title with one each of a Flip Chart, Training
Guide & Classroom Activities. Regular Price $66.85

10% Discount on your next order
within 90 days of this purchase. 
Use special discount code #T2T-0507

Total from other side

SUBTOTAL

(CO & FL shipments add applicable sales tax) Tax
Tax Exempt # __________________

Shipping

Order TOTAL

Print Cost $795.00 x ______ = ________

eBook Cost $675.00 x ______ = ________
(Save over 50% or $800) Quantity _Total Cost

2) MS Office XP Classroom Bundle Includes one Flip Chart,
Training Guide, Classroom Activities for Word, Excel & PowerPoint & one
Teachers User Guide and 25 Student User Guides for Word, PowerPoint
& FrontPage. Regular Price $1,636

Ordering Info: All orders must be accompanied by
either a purchase order from a recognized institution
or payment by check or credit card.

Classroom Bundle
Print Cost $295.00 x ______ = ________

eBook Cost $195.00 x ______ = ________
(Save over 40% or $180) Quantity _Total Cost

Please Specify Titles:

Any One Title with one Teacher User Guide and 25 Student User Guides.
Regular Price $478




